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NetSim- Multi-Parameter Sweeper Python Ver 15.0

Software: NetSim v15.0 (64 bit), NET Core SDK 3.1, Python 3.11.1 or later.

Project download link:
https://github.com/NetSim-TETCOS/Multiparameter-Sweeper-Python-
v15.0/archive/refs/heads/main.zip

1 Introduction

NetSim Multi-Parameter Sweeper automates the network simulation process by running NetSim
through the command line interface. Instead of changing parameters and analyzing results
manually in the GUI, users mark the input parameters to vary, run the Python script, and
collect output metrics in CSV files.

2 File Organization

The project directory contains the helper executables, supporting DLL files, input configuration,
metric scripts, and Python script used during a multi-parameter sweep.

I M = | Multi-Parameter-Sweeper - O ®
Home  share  View 7]
» |J 4 cut x E‘_jNew item = \ﬂ_ open -~ FHsetectall
w.| Copy path T‘J Easy access = Edit Select none
Pinto Quick Copy Paste Move Copy  Delete Rename  New Properties ) _
access [#] Paste shorteut to to - folder - & History DD Invert selection
Clipboard Organize New Open Select
< v o <« Multi-Parameter_S... » Multi-Parameter-Sweeper > v O O Search Multi-Parameter-Sweeper
Mame - Date modified Type Size
7 Quick access
ConfigSupport File folder
@ OneDrive - Personal |j configwriter.dil Application exten... 5KB
» [ This PC [ ConfigWriter.exe Application 171 KB
T o ConfigWriter.runtimecenfig.json JSON File 1KB
¥ Network [ Inputxml XML Document 3B KB
[8] MetricsCsv.exe Application 58KB
|j metricsreader.dll Application exten... 5KB
[8] MetricsReader.exe Application 171 KB
LT MetricsReader.runtimeconfig.json JSON File 1KB
E MultiParameterSweeper.m M File 5KB
E MultiParameterSweeper.py Python File G KB
|j MetSimMetricsReader.dll Application exten... 10KB
|j MetSimXmlReader.dll Application exten... 5KB
|J Script.txt Text Document 1KB
14items  State: Bl Shared =

Figure 2-1: Project directory with sweeper binaries and script files

2.1 Input Configuration
Input.xml contains the base NetSim network configuration. Create this file by saving a network

scenario in NetSim v15.0, copying Configuration.netsim, and renaming it to Input.xml.
Copy the ConfigSupport folder along with Input.xml.

Copyright TETCOS LLP Page 4 of 27


https://github.com/NetSim-TETCOS/Multiparameter-Sweeper-Python-v15.0/archive/refs/heads/main.zip
https://github.com/NetSim-TETCOS/Multiparameter-Sweeper-Python-v15.0/archive/refs/heads/main.zip

NetSim- Multi-Parameter Sweeper Python Ver 15.0
0Q File Edit View Gt Project Debug XML Test Analyze Tools Extensions Window Hep | © Seach+  Solutionl R Signin - 8 x
|@-2B@|9- || g | | p A - BB & Gittub Copict 12 )
=t

F’xml version="1.0" encoding="UTF-8" standalone="no"?>
v <TETCOS_NETSIM xmlns: nsO="http://www.w3.0rg/2001/XMLSchema-instance" noNamespaceSchemalLocation="Configuration.xsd">
> FEXPERIMENT_INFORMATION>A o A</EXPERIMENT_INFORMATION>|

> EGUI_INFORMATIUN» 0 _</GUI_INFORMATION3|

v~ <NETWORK_CONFIGURATION>

> <LAYER TYPE="APPLICATION_LAY">...</LAYER>|
> <LAYER TYPE="TRANSPORT_LAYER">...</LAYER>|
>L <LAYER TYPE="NETWORK_LAYER">...</LAYER>|
v

>

A

DEVICE>

A

<P0S_3D X_OR_LOI
<INTERFACE ID="1" INTERFACE_NAME="Interface_1 (Et" INTERFACE_TYPE="ETHERNET">...</INTERFACE>|
> <INTERFACE ID="2" INTERFACE_NAME="Interface 2 (Et" INTERFACE_TYPE="ETHERNET">...</INTERFACE>|
> <LAYER TYPE="APPLICATION_LAY">...</LAYER>|

="10" Y_OR_LAT="160.022355219151551" Z="0" COORDINATE_SYSTEM="Cartesian" ICON_ROTATION="0" />

> [<INTERFACE ID="2" INTERFACE_NAME="Interface 2 (Et" INTERFACE_TYPE="ETHERNET">...</INTERFACE>|
L </DEVICE>
v
>

<DEVICE KEY="WirelessNode" DEVICE_NAME="STA_4" DEVICE_ID="u4" TYP
<P0S_3D X_OR_LON="15" Y_OR_LAT="{@}" Z="@" COORDINATE_SYSTEM="Cartesian" ICON_ROTATION="@" />

> [<INTERFACE ID="1" INTERFACE_NAME="Interface 1 (Wi" INTERFACE_TYPE="WIRELESS">...</INTERFACE>|
2 I<I AVER_TVDF="ADDI TCATTON [ AV"> _ </I AVER>|

o isues found

v <DEVICE_CONFIGURATION DEVICE_COUNT="4">

v <DEVICE KEY="WiredNode" DEVICE_NAME="Server_1" DEVICE_ID="1" TYPE="NODE" WIRESHARK_OPTION="Disable" INTERFACE_COUNT="1" DI
| <P0OS_3D X_OR_LON="5" Y_OR_LAT="10" Z="@" COORDINATE_SYSTEM="Cartesian" ICON_ROTATION="0" />

> <INTERFACE ID="1" INTERFACE_NAME="Interface_l (Et" INTERFACE_TYPE="ETHERNET">...</INTERFACE>]

DEVICE KEY="Router" DEVICE_NAME="Router_2" TYPE="ROUTER" DEVICE_ID="2" WIRESHARK_OPTION="Disable" INTERFACE COUNT="2" DEY

> <LAYER TYPE="TRANSPORT_LAYER">. . .</LAYER>|

> <LAYER TYPE="NETWORK_LAYER">. ..</LAYER>]

L </DEVICE>

v <DEVICE KEY="Accesspoint" DEVICE_NAME="Access_Point_3" DEVICE_ID="3" TYPE="ACCESSPOINT" WIRESHARK_OPTION="Disable"
| <P0S_3D X_OR_LON="15" Y_OR_LAT="10" Z="0" COORDINATE_SYSTEM="Cartesian" ICON_ROTATION="0" />

> [<INTERFACE ID="1" INTERFACE_NAME="Interface 1 (Wi" INTERFACE_TYPE="WIRELESS">...</INTERFACE>

="NODE" WIRESHARK_OPTION="Disable" INTERFACE_COUNT="1" DI

INTERF}

1 oni sec GuiF

Figure 2-2: Input.xml file with NetSim configuration parameters to sweep

The values of parameters to vary during each simulation run must be specified as {0}, {1}, {2},

and so on. For example, the Y coordinate of a device can be replaced with {03}.

80 %t e e G B A e e e e | Bt e fsmn - 8 %

la-sRmm|2-- ] w1 R
Inpar %
=?xml wersion="1.@" encoding="UTF-8" standalome="mo"?>

~ <TETCOS_NETSIM xmlns:ns@="http://www.w3.org/2001/XML Schema-instance” nollamespaceSchemalocation="Configuration.xsd">
% EXPERIMENT_INFORMATION=. .. </EXPERIMENT_INFORMATION=
* EGUI_INFORMATION=. . .</GUI_INFORMATICN>

~ =NETWORK_CONFIGURATION=

v <DEVICE_CONFIGURATION DEVICE COUNT="4"=

> [*DEVICE HEY=

iredNode" DEVICE_NAME="Serwver_1" DEVICE_ID="1" TYPE="WODE" WIRESHARK_OPTION="Disable" INTERFACE_COUNT:

& b ot 2

</TETCOS_NETSIM=>

Fue it e Il

Figure 2-3: Y coordinate placeholder modified in Input.zml

2.2 Metric Script

> <DEVICE HEY="Router" DEVICE_NAME="Router_2" TYPE="ROUTER" DEVICE_ID="2" WIRESHARK_OPTION="Disable" INTERFACE_COUNT=
¥ DEVICE KEY="Accesspoint" DEVICE_NAME="Access Point 3" DEVICE_ID="3" TYPE="ACCESSPOINT" WIRESHARK_OPTION="Disable" INTERF;
~ <DEVICE HEY="WirelessMode" DEVICE_HNAME="STA_0" DEVICE_ID="0" TYPE="NODE" WIRESHARH_OPTION="Disable" INTERFACE_COUNT="1" DI
<P0S_30 X_DR_LON="15%[Y_OR_LAT="{8}"| Z="0" COORDINATE_SYSTEN="Cartesian" ICON_ROTATION="@" /=
? <INTERFACE ID="1" INTERFACE_NAME="Interface 1 (Wi" INTERFACE TYPE="WIRELESS">.. </INTERFACES
b [ELAYER TYPE="APPLICATION_LAY">...
3
5 LAYER TYPE="NETWORK_LAYER">. ..
< /DEVICE>

</DEVICE_CONFIGURATION=
b CONNECTION=>. ..</CONNECTION=|
> <APPLICATION_CONFIGURATION COUNT="1">...</APPLICATION_CONFIGURATION=
[_ </NETWORK_CONFIGURATION=
> [ESIMULATION_PARAMETER SIMULATION_EXIT_TYPE="Time® SIMULATION_TIME="18">...</SINULATION_PARAMETER=|
*  PROTOCOL_CONFIGURATION=. . .=/PROTOCOL_CONFIGURATION-]
|> [ESTATISTICS COLLECTION>...</STATISTICS COLLECTIONS]

[ER TR 113

Script.txt is updated with the output metric that must be logged at the end of each simulation
run. NetSim writes metrics to Metrics.xml; the metrics reader uses the script file to locate the

selected metric and append it to the result CSV.
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) e Ed View Gt Pmpa Debg ML et Abae Took  Etrvions Window Melp | O Sewh-  Sousonl

B signin o x
fe-o|@-=A8(9- - b oavach - BBl

& Gttub Copit (8
> [€MENU Name="TEFE802.11_Metr">.. </MENLI>‘
v <MENU Name="Application_Metrics">
~  <TABLE name="Application Metrics">

<TH name="Application ID" isShow="true"/>

<TH name="Application Name" isShow="true"/>
<TH name="Source ID" isShow="false"/>
<TH name="Destination ID" isShow="false"/>
<TH name="Generation Rate (Mbps)" isShow="false"/>
<TH name="Packets Generated" isShow="true"/>
<TH name="Packets Received" isShow="true"/>
<TH name="Payload generated (bytes)" isShow="false"/>
<TH name="Payload received (bytes)" isShow="false"/>
<TH name="Throughput (Mbps)" isShow="true"/>
<TH name="Delay (microsecond)" isShow="true"/>
<TH name="Jitter (microsecond)" isShow="true"/>
~ <TR>
<TC Value="Appl_CBR"/>
<TC Value="1"/>
<TC Value="4"/>
<TC Value="100.690000"/>
<TC Value="86207"/>
<TC Value="15301"/>
<TC Value="125862220"/>
<TC Value="22339460"/>
<TC Value="3709761.401874"/>
<TC Value="388.136639"/>
</TR>
s ALAELES

O g g g

Figure 2-4: NetSim output Metrics.xml file

For example, to log application throughput for each simulation run, update Script.txt with
the application metrics table and throughput field.

) Seript.tet - Notepad - O x
File Edit Format Yiew Help

MENU NAME="Application_Metrics"

TABLE NAME="Application_Metrics"

SET A="Throughput (Mbps)" WHERE "Application 1d"="1"

Figure 2-5: Application throughput metric configured in Script.tzt

2.3 Helper Executables and Python Script

ConfigWriter.exe: This executable takes one or more command line arguments as input

and generated Configuration.netsim file by replacing the arguments in place of the variable
parameters specified in the input.xml file.

If there are two variable parameters specified in the input.xml file ({0} and {1}) then two
arguments need to be passed while calling ConfigWriter.exe.

MetricsCSV.exe: This executable is used to convert the Metrics.xml file present in the
output folder into a comma separated file, MetricsPrint.csv.

MetricsReader.exe: This executable is responsible for reading the output parameter from
the Metrics.xml file generated after each simulation and logging it to the results file.

It uses the Script.txt file to determine which parameter to read from the Metrics file.

If multiple parameters are to be read and logged, then the MetricsReader.exe can be called
multiple times with Script.txt file having information about the parameter to be read each
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time.

Supporting DLL’s: Some the supporting files such as ConfigWriter.dll, MetricsReader.dll,
NetSimMetricsReader.dll, NetSimXmlReader.dll, etc. which are present in the project folder are
used by other executable such as ConfigWriter.exe and MetricsReader.exe for various purposes
during a multi-parameter sweep.

MultiParameterSweeper.py uses python programming language which is less complex and
offers more flexibility as the number of input and output parameters increases.

e Users can also write the script to run the multi-parameter sweep process in a preferred
programming language as per the convenience.

e The script can be configured to run multiple simulation iterations based on the number
of parameters to be varied and the range of values of each parameter.

o NETSIM_PATH variable can be set to the path of NetSim 64-bit binaries (bin_x64) in the
install directory or workspace which is to be used to run Simulations.

e LICENSE_ARG variable can be set to License server port and IP details in case of floating
on premise licenses or the path of license file in case of node locked or cloud licenses.

1 import subprocess

2 import shlex

3 import random

4 import shutil

5 import math

6 import sys

7 import datetime

8 import time

9 import os

10

11 # Set the path of 64 bit NetSim Binaries to be used for simulation.
12 NETSIM_PATH = "C:\\Program Files\\NetSim\\Standard_v15_8\\bin\\bin_x64"

# Floating on-premise License

[
w

14 LICENSE_ARG = "5853@192.168.8.4"

15 # Node Locked or Cloud licenses (path of license file):

16 # LICENSE_ARG="\"C:\\Program Files\\NetSim\\Standard_v15_8\\bin\\bin_x64\"";

17

18 # Set NETSIM_AUTO environment variable to avoid keyboard interrupt at the end of each simulation

;3 os.environ["NETSIM_AUTO"] = "1"

21 # Create IOPath directory to store the input Configuration.netsim file and the simulation output
22 -if not os.path.exists("IOPath"):

23 os.makedirs("IOPath")

Figure 2-6: NetSim path in the updated Python script

For NetSim v15.0, set:

NETSIM_PATH = "C:\\Program Files\\NetSim\\Standard_v15_O\\bin\\bin_x64"
LICENSE_ARG = "50530192.168.0.4"

# Node Locked or Cloud licenses (path of license file):

# LICENSE_ARG="\"C:\\Program Files\\NetSim\\Standard_v15_O\\bin\\bin_x64\"";

3 Running the Sweeper

e The MetricsCSV.exe will convert the Metrics.xml file inside the output folder into a csv
file.
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MultiParameterSweeperpy & X

89
20
91
92
93
94
95
96
97
98
929
100
lel
102
103
le4d
105
106
107
108

100

# print(emd)
os.system(cmd)

# Create a copy of the output Metrics.xml file for writing the result log
if os.path.isfile("IOPath\Metrics.xml"):
shutil.copy("IOPath\Metrics.xmlL", "Metrics.xml")
| os.system("MetricsCsv.exe I0Path™)]

# Number of Script files i.e Number of Output parameters to be read from Metrics.xml

# If only one output parameter is to be read only one Script text file with name Script.txt to
# If more than one output parameter is to be read, multiple Script text file with name Scriptl
# ...,Scriptn.txt to be provided

OUTPUT_PARAM_COUNT = 1

if os.path.isfile("Metrics.xml"):
# Write the value of the variable parameters in the current iteration to the result log
csvfile = open("result.csv", "a")
csvfile.write("\n" + str(i) + ", ")
csvfile.close()

Figure 3-1: MetricsPrint.csv file will be created in the IOPath and then copied into the respective output

folder

o Multi-Parameter Sweeping process is started by opening command prompt in the directory
of the Multi-Parameter-Sweeping project and starting the python script as shown below:

BER C:\Windows\System32\cmd.exe — O ®

Figure 3-2: Running the Python script from Command Prompt

e This starts the Multi-Parameter-Sweeping process which runs NetSim simulations itera-
tively for different values of Y parameter of Wireless Node.

o At the end of the process the Multi-Parameter-Sweeping folder will have the following file
and folders created:
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| = | Multi-Parameter-Sweeper
Home Share View
o cut

# B0 e B X =f

w.| Copy path

Pinto Quick Copy Paste _ Move Copy Delete Rename
access E] Faste shortcut tor to- -
Clipboard Organize
&« v A < Multi-Parameter_Swe... » Multi-Parameter-Sweeper
~
Mame
# Quick access
ConfigSupport
@ OneDrive - Personal Data
= This PC I0Path
- configwriter.dll
[_} Network [#5] ConfigWriter.exe

in) ConfigWriter.runtimeconfig.json
D Input.xml
[35] MetricsCsv.exe

| metricsreader.dll
[5] MetricsReader.exe
in) MetricsReader.runtimeconfig.json
. MultiParameterSweeper.m

[# MultiParameterSweeper.py
MNetSimMetricsReader.dll
NetSim¥mIReader.dll

@ result.csv

D Script.xt

Ver 15.0

i Mew item = T Open e select
ﬂEasy access v . Edit 1o Seledt
f':fdu:r PrOvaI"tIEs = History |jE‘|Ir1\rert
New Open Sel
v O 2 Search Multi-Parameter-Sweeper
Date medified Type Size
08-12-2023 17:56 File folder
07-12-2023 11:05 File folder
07-12-2023 11:08 File folder
14-03-2023 18:19 Application exten... 5KB
14-03-2023 18:19 Application 171KE
JSON File TKB
XML Document 38 KB
Application 58 KB
Application exten... SKB
Application 171 KB
14-03-2023 JSON File TKB
06-12-2023 M File 5KB
07-12-2023 Python File 6 KB
14-03-20231 Application exten... 10KB
14-03-2023 Application exten.. SKB
07-12-2023 Microsoft Excel C... TKB
14-03-2023 Text Document TKB

Figure 3-3: After Simulation Multi-Parameter-Sweeping folder contains output files like result.csv, Data

etc

o Data: Contains multiple folders created based on date and time of simulation inside which
multiple output folders corresponding to each simulation run, with its name including the
value of the parameters in that iteration gets created.
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Data x |+ = B o=
&« qr c Qo > Multi-Parameter-Sweeper-Example-1 > Data > Search Data
& Mew TL Sort = View (D Details
e Name Date modified Type Size
| =5 2024-10-29.11.27.13 29-10-2024 11:27 File Folder
2024-10-29-1127.13 x |+ = & =
e 4k (%] (I I Data > 2024-10-29-11.27.13 > Search 2024-10-29-11.27.13 |
@ New T Sert = View (3 Oetails
> Wl Desktop Name Date modified Type Size
|7 output 20 File folder
Output_30 File folder
Output_40 File folder
1 item Output_50 File folder
B result.csv Microsoft Excel C... 1KB |
|
|
5 items E o

Figure 3-4: Based on values in the iteration, Output folder gets created in the Data directory inside
folder named as per date and time of simulation along with a copy of result.csv file.

e Each folder contains the all the output files associated with the simulation run.

Output_20 x + B o x
[ q (] o > Data > 2024-10-29-11.27.13 » Output 20 > Search Output_20
® MNew ~ Tl Sort - = View - . (E Details
> N Desktop Name Date modified Type Size
ConfigSupport 28-10-202415:26 File folder
log 29-10-202411:27 File folder
D Configlog.txt 29-10-2024 11:27 Text Document 19 KB
D'qunfiguration.netswm 29-10-202411:27 METSIM File 16 KB
D ethernet_log et 29-10-2024 11:27 Text Document 1KB
D Licenselog.bet 29-10-202411:27 Text Document 1KE
D LogFiletxt 29-10-202411:27 Text Document SKB
(,rﬂ Metricsacml 20-10-202411:.27 #ML Document 12KB
@MetncsPrint.csv 29-10-2024 11:27 Microsoft Excel C... 4KB
D SpanningTreetxt 29-10-2024 11:27 Text Document OKB
D StaticARP bt 29-10-202411:27 Text Document 1KE
D StaticARP1.tet 29-10-202411:27 Text Document 1KB
12 iterns E O

Figure 3-5: Fach folder contains all the output files and the Metrics.xml file converted to Metric-

sPrint.csv file

Note: User should keep a back-up of the data folder to avoid data loss.

e IO Path: Used for storing the Configuration.netsim file and the simulation files gen-

erated during each simulation run.
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e Result.csv: This is the output log which contains the parameter varied during each
simulation run and the output parameter associated with each run. The result.csv file
will also be copied into the output folder after each simulation.

. result.csv - Ex.. mal - a *
Horr Inser Page Forrr Data Rewie View Help [
E17 - I v

A B C

1 Y THROUGHPUT({Mbps)

2 20 21.616176

3 30 14.703952

4 40 9.5361248

3 30 a

&

’ -]

et ® ¢ L] [0

EH M -+ 10m%
Figure 3-6: Iterated value and Throughput obtained listed in result.csv
4 Example 1: Single Input Parameter

Consider an Internetwork scenario in NetSim v15.0 with a wired node, router, access point, and
wireless node.

Zerwer_1 -ﬁ.ccess_'r:'n'lntj

1! CBR 4

STE_4

Figure 4-1: Network topology for the single-parameter sweep

The network configuration has the initial distance between the Access Point and Wireless Node
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as 10 meters with the Access Point located at (15,10) and Wireless Node located at (15,20).
Multi-Parameter Sweeper is configured to run simulations for different distance between the
Access Point and Wireless Node by varying the Wireless Node Y coordinate value from 20 to
50 in steps of 10 meters.

The network scenario is saved and the content of the Configuration.netsim file is copied to
the Multi-Parameter-Sweeper directory and renamed as input.xml. Refer to the Example 1
directory which is part of the project folder:

Examples\Multi-Parameter-Sweeper-Example-1

Home Share View
» Ij dh Cut x 7 New item ~ \;] open - HH select an

w-| Copy path g Tj Easy access = Edit Select none

Pinto Quick Copy Paste = Move Copy Delete Rename Mew Properties
access E Paste shortcut to to - folder - £ History DD Invert selection
Clipboard Organize MNew Open Select
« v » ThisPC » Downloads » Multi-Parameter_Sweeper_v14.0-main + Examples » Multi-Parameter-Sweeper-Example-1
Mame : Date modified Type Size
7 Quick access
ConfigSupport 07-12-2023 14:41 File folder
@, OneDrive - Personal %] configwriter.dil 14-03-2023 18:19 Application exten... 5KB
O This PC [#] ConfigWriter.exe 14-03-2023 18:19 Application 171 KB
o LT ConfigWriter.runtimeconfig.json 14-03-2023 18:19 JSOM File 1KB
=¥ Network [ Inputxml 07-12-2023 09:41 XML Document 38 KB
[#] MetricsCsv.exe 14-03-2023 18:19 Application 58 KB
|:] metricsreader.dll 14-03-2023 18:19 Application exten... 5KB
[5] MetricsReader.exe 14-03-2023 18:19 Application 171 KB
LT MetricsReader.runtimeconfig.json 14-03-2023 18:19 JSOM File 1KB
E MultiParameterSweeper.m 14-03-2023 18:19 M File 5KB
[ MultiParameterSweeper.py 07-12-2023 11:47 Python File 6 KB
|:] MetSimMetricsReader.dll 14-03-2023 18:19 Application exten... 10KB
%] NetSimXmiReader.dll 14-03-2023 18:19 Application exten... 5KB
|:] Script.bet 14-03-2023 18:19 Text Document 1KB

Figure 4-2: Renamed Configuration.netsim to input.cml and pasted in Multi- Parameter-Sweeper direc-
tory

e The value of the Y coordinate of Wireless Node that is to be modified during each simu-
lation run is updated ({03}) in the configuration file as shown below:
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O Fi Bt Wi GE o Pt Osbug ML @ Anam  Tesk  Btwsises  Windew  Help | P Sarhe Saution) R sgnin - - ®
ERENE 1311 TR - | p e e | B & GiHub Coplot 15; &
it &
<?xml version="1.8" encoding="UTF-8" standalone="no"?>

~ <TETCOS_NETSIM xmlns:ns@="http://wuw.w3.org/2001/XMLSchema-instance™ noNamespaceSchemalocation="Configuration.xsd">

)} [EEXPERIMENT_INFORMATION=>. . .</EXPERIMENT_INFORMATION>|

> lﬁUI_INFORNATIGN). B .</GUI_INFDRI‘IATIDM>~{

v <NETWORK_CONFIGURATION>

v <DEVICE_CONFIGURATION DEVICE_COUNT="4">
% I<DEVICE KEY="WiredNode" DEVICE_NAME="Server_1" DEVICE_ID="1" TYPE="NODE" WIRESHARK_OPTION="Disable" INTERFACE_COUNT="1" D
3 [<DEVICE KEY="Router" DEVICE_NAME="Router_2" TYPE="ROUTER" DEVICE_ID="2" WIRESHARK_OPTION="Disable" INTERFACE_COUNT="2" DE
? [<DEVICE KEY="Accesspoint” DEVICE_NAME="Access_Point_3" DEVICE_ID="3" TYPE="ACCESSPOINT" WIRESHARK_OPTION="Disable" INTERF
~ <DEVICE KEY="WirelessNode" DEVICE_NAME="STA_4" DEVICE_ID="4" TYPE="NODE" WIRESHARK_OPTION="Disable" INTERFACE_COUNT="1" D =
| <P0OS_3D X_OR_LON="15" Z="@" COORDINATE_SYSTEM="Cartesian" ICON_ROTATION="@" />
> <INTERFACE ID="1" INTERFACE_NAME="Interface_1 (Wi" INTERFACE_TYPE="WIRELESS">...</INTERFACE=|
> <LAYER TYPE="APPLICATION_LAY">...</LAYER>|
> <LAYER TYPE="TRANSPORT_LAYER">...</LAYER>|
>
|
T
>
3
T

<LAYER TYPE="NETWORK_LAYER">...</LAYER]
DEVICE=>
</DEVICE_CONFIGURATION>
[<CONNECTION>. . . </CONNECTIONS]
BDPLICATIGN_COMFIGLIRATIGN COUNT="1">...</APPLICATION_CONFIGURATION>]
</NETWORK_CONFIGURATION>
SIMULATION_PARAMETER SIMULATIOW_EXIT_TYPE="Time" SIMULATION_TIME="18">...</SIMULATION_PARAMETER>|
PROTOCOL_CONFIGURATION>. . .</PROTOCOL_CONFIGURATIONS]
STATISTICS_COLLECTION>...</STATISTICS_COLLECTION
/TETCOS_NETSIN>

A

A

Figure 4-3: Modified Y coordinate of Wireless Node in input.xml

e The Script.txt file is updated with the details of the output parameter to be read from
the Metrics.xml file and added to the result csv log file. In this case the Application
throughput is to be logged for each simulation run.

| Seript.tet - Notepad - O X
Eile Edit Format Miew Help

IMENU NAME="Application_Metrics"

TABLE NAME="Application_Metrics"

SET A="Throughput (Mbps)" WHERE "Application 1d"="1"

Figure 4-4: The application throughput is to be logged for each simulation modified in Script.txt

4.1 Python Script Changes

e MultiParameterSweeper.py is updated to pass the Y coordinate value during each iter-
ation to generate Configuration file, run simulation, and update the result csv log.

The MultiParameterSweeper.py python script modified for running simulations for different
values of Y coordinates starting from 20 up to 50 in steps of 10 is shown below:

o A result.csv file is created and added with headings Y and Throughput (Mbps).
e A MetricsPrint.csv is created inside every output folder.

e For loop is set to iteratively run simulations for values starting from 20 to 50 in steps of
10.
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e The value of the parameter Y in the current iteration is written to the result log file for
analysis.

e The value of the parameter Y in the current iteration is passed as input to ConfigWriter
executable to generate Configuration.netsim file for each simulation.

e NetSim simulation is run via CLI mode by passing the apppath, iopath and license server
information.

e Configuration file and Metrics file are copied and renamed appending the value of the
parameter in the current iteration.

MultiParameterSweeperpy & X

10

11 # Set the path of 64 bit NetSim Binaries to be used for simulation.

12 NETSIM PATH = "C:\\Program Files\\NetSim\\Standard_v15_ @\\bin\\bin_x64"

13 # Floating on-premise License

1y LICENSE ARG = "5053@192.168.0.4"

15 # Node Locked/ Cloud License

16 # LICENSE_ARG="\"C:\\Program Files\\NetSim\\Standard_v15_ @\\bin\\bin_x6&4\"";

17

18 # Set NETSIM_AUTO environment variable to avoid keyboard interrupt at the
19 os.environ["NETSIM_AUTO"] = "1"

20

21 # Create IOPath directory to store the input Configuration.netsim file and
22 —-if not os.path.exists("IOPath"):

23 os.makedirs("IOPath")

24

25 # Create Data directory to store the Configuration.netsim and the Metrics.
26 —-if not os.path.exists("Data"):

27 os.makedirs("Data")

28

29 # Clear the IOPath folder if it has any files created during previous mult
30 —for root, dirs, files in os.walk("IOPath"):

31 - for file in files:

32 os.remove(os.path.join(root, file))

33

34 # Delete result.csv file if it already exists

35 —if os.path.isfile("result.csv"):

36 os.remove("result.csv")

37

3 # create a csv file to log the output metrics for analysis

39 csvfile = open("result.csv", "w")

4e

u1 # Add headings to the CSV file

42 | csvfile.write("Y, THROUGHPUT(Mbps),") |

u3 csvfile.close()

Figure 4-5: To Create result.csv file, added with headings Y and Throughput (Mbps) and NetSim
installation Path and License information

e NETSIM_PATH variable is set to the path of NetSim 64-bit binaries in the install directory
or workspace in the system.

e LICENSE_ARG variable is set to the license server details.

o A result.csv file is created and added with headings Y and Throughput (Mbps).
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File Edit Selection View Go Run - « £ search mBMmo - o

% MultiParameterSweeperpy X Do @ -

€: > Users > mihit > D

)

i

L 2 cvitewr
P

veeper V142 > Examples > Multi-Parameter-Sweeper-Fxample-1 > & MultiParameterSweeper py >

> Multi-Paramete

¥, THROUGHPUT (Mbps ), ")

43 gsyfile.close()

45 # Create a folder with name as year-menth-day-hour.minute.seconds inside the data folder
46 today = time.strftime("¥Y-%m-%d-%H. MM %5")
,3'5 47 foldername = str(today)

43
(m] 45 _# Iterate based on the number of times the simulation needs to be run and the input parameter range

51 i

A 52 if os.path.isfile("Configuration.netsim"):
53 | os.remove("configuration.netsin”)
54
55 if os.path.isfile("IOPath\\Configuration.netsim"):
56 s. remove (" I0Path\ \Configuration. netsim”)
57
1] if os.path.izfile("IOPath\\Metrics. xml™):
59 os.remove("IOPath\ \Metrics. xml")
L]
61 # Call configWriter. exe with arguments as per the number of variable parameters in the input.xml file
@
63 printicm
54 0s. system{cmd)
65
66 # Copy the Configuration.netsim fils genesrated by ConfigWiriter.exe to IOPath dirsctory
67 if os.path.isfile("Configuration.ne :
68 shutil.copy("Configuration.nets "IOPath\\Configuration.netsim®)

® 69
78 # Copying the Additional Files folder

{g} 71 if os.path.exists('ConfigSupport')
72 # Remove the existing 'ConfigSupport' directory in 'IOPath' if it exists

n ®@oAo Wo G Lns3Cold2 Spacesid UTF-8 LF {) Python 312764bit 0L

Figure 4-6: Varying Distance and set license server information

e For loop is set to iteratively run simulations for values starting from 20 to 51 in steps of
10.

o The value of the parameter Y in the current iteration is passed as input to ConfigWriter
executable to generate Configuration.netsim file for each simulation.

MultiParameterSweeperpy & X

100 # If more than one output parameter is to be read, multiple Script text
101 # ...,Scriptn.txt to be provided

102 OUTPUT_PARAM_COUNT = 1

163

104 = if os.path.isfile("Metrics.xml"):

105 # Write the value of the variable parameters in the current iteratio
106 csvfile = open("result.csv",k "a"

107 csvfile.write("\n" + str(i) + ",")

108 csvfile.close()

109

110 - if OUTPUT_PARAM_COUNT == 1:

111 # Call the MetricsReader.exe passing the name of the output log -
112 0s.system("MetricsReader.exe result.csv")

113 = else:

114 - for n in range(l, OUTPUT_PARAM_COUNT + 1, 1):

115 os.rename("Script" + str(n) + ".txt", "Script.txt")

116 os.system("MetricsReader.exe result.csv")

117 csvfile = open("result.csv", "a")

118 csvfile.write(",")

119 csvfile.close()

120 os.rename("Script.txt", "Script" + str(n) + ".txt")

121

122 = else:

123 # Update the output Metric as crash if Metrics.xml file is missing
124 csvfile = open("result.csv", "a")

125 | csvfile.write("\n" + str(i) + "," + "crash" + ", ") |

126 csvfile.close()

127

128 # Name of the Output folder to which the results will be saved

129 |0UTPUT=PATH = "Data\\" + str(foldername) + "\\Output " + str(i)|

130

Figure 4-7: Modify parameters in MultiParameterSweeper.py
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e The value of the parameter Y in the current iteration is written to the result log file for
analysis.

e Configuration file and Metrics file are copied and renamed appending the value of the
parameter in the current iteration.

e Multi-Parameter Sweeping process is started by opening command prompt in the directory
of the Multi-Parameter-Sweeping project and starting the python script as shown below:

EX C\Windows\System32\cmd.exe - m} X

Figure 4-8: Running Example 1 from Command Prompt

This starts the Multi-Parameter-Sweeping process which runs NetSim simulations iteratively
for different values of Y parameter of Wireless Node.

At the end of the process the Multi-Parameter-Sweeping folder will have the following file and
folders created:

V] = | Multi-Parameter-Sweeper-Example-1
Home Share View
do Cut i x -Il L_‘J Mew item ~ W m Open ~ ESeled all
= = Copy path ﬁ EJ Easy access = J Edit Select none
Pinto Quick Copy Paste Move Copy Delete Rename Mew Properties
access | Paste shortcut tow to- - folder - History DEI Invert selection
Clipboard Organize New Open Select
< v <« Examples » Multi-Parameter-5weeper-Example-1 v | D Search Multi-Parame
MName - Date modified Type Size
7 Quick access
ConfigSupport File folder
@ OneDrive - Personal Data File falder
3 This PC 10Path File folder
| configwriter.dIl Application exten... 5KB
¥ Network [5] Config\Writer.exe Application 171 KB
IT ConfigWriter.runtimeconfig.json JSOM File 1 KB
| Inputxml XML Document 38 KB
[®5] MetricsCsv.exe Application 58 KB
| metricsreader.dll Application exten... 5KB
[#] MetricsReader.exe Application 171 KB
LT MetricsReader.runtimeconfig json JSON File 1 KB
E MultiParameterSweeper.m M File 5KB
[ MultiParameterSweeper.py Python File 6 KB
| MetSimMetricsReader.dll Application exten... 10 KB
%] MetSimXmlReader.dll Application exten... 5KB
@ result.csv Microsoft Excel C... 1KB
=| Script.txt Text Document 1 KB

Figure 4-9: After Simulation Multi-Parameter-Sweeping folder contains output files like result.csv, Data
etc

o Data: Contains multiple folders corresponding to each simulation run, with its name
including the value of the parameters in that iteration. The output folders will be created
inside folder with name in the format Year-Month-Day-Hours-Minutes-Seconds.
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« +

& Mew

> Wl Desktop

1 item

5items

< BB - o x
Qo > Multi-Parameter-Sweeper-Example-1 > Data > Search Data
T Sort = View (I Details
Name - Date modified Type Size
2004-10-29-11.27.13 29-10-2024 11:27 File folder
2024-10-29-11.27.13 x W
(= iy [&] Qo Data > 2024-10-29-11.27.13 >
@ New N Sort = View
N ater fied Typ
> W Desktop ame Date modifie: ype
N Output_20 File folder
Output_30 File folder
Output_40 File folder
Output_50 File folder
@ result.csv

Microsoft Excel C...

Ver 15.0

= o X
Search 2024-10-29-11.27.13 |

(B Oetails

1KB

Figure 4-10: Based on distance Configuration.netsim files created in output folder

o Each folder contains the all the output files associated with the simulation run.

Qutput_20

<«

@Nawv

> [ Desktop

12 iterns

x +
(] o > Data >
#
MName
ConfigSupport

log
D Configlog.tct
D'q Configuration.netsim
D ethernet_log.bet
D Licenselog.bet
=] LogFiletst
L Metricsxml
@ MetricsPrint.csv
D SpanningTreetet
] staticARP.txt

=] staticARP1.xt

2024-10-29-11.27.13 >  QOutput 20 >
T Sort v = View ~ B
Date modified Type
28-10-2024 15:26 File folder
29-10-2024 11:27 File folder

-10-2024 11:27

ra
[

-10-2024 11:27

[
w5

-10-2024 11:27

o
w

-10-2024 11:27

ra
=]

ra
=]

-10-2024 11:27

-10-2024 11:27

ra
[

5]

-10-2024 11:27

ra

24 11:27

o
w

ra
o

P
=]

-10-2024 11:27

Text Document
METSIM File

Text Document
Text Document
Text Document

XML Document

Size

Microsoft Excel C...

Text Document
Text Document

Text Document

1KE

1KB

5KB

12KB

4KB

OKB

1KB

1KB

Search Output_20

[ Details

Figure 4-11: Each folder contains

the all the output files

o IOPath: Used for storing the Configuration.netsim file and the simulation files gener-

ated during each simulation run.

e Result.csv: This is the output log which contains the parameter varied during each

simulation run and the output parameter associated with each run.

Copyright TETCOS LLP
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|

r result.csv - Ex.. = -
Horr Inser Page Forrr Data Rewie View Help [
E17 - I
A B
1 Y THROUGHPUT({Mbps)
2 20 21.616176
3 30 14.703952
4 40 9.5361248
3 30 a
&
7
resuli )]

x

W

[+]
[v]

H @ ™M -—3—+ 100

Figure 4-12: Distance Vs. Throughput obtained in result.csv

Ver 15.0

In order to vary multiple network parameters during the multi-parameter sweep process each
parameter in the input.xml file can be modified as {0}, {1}, {2}, {3},.. {n} respectively.

Logging multiple output parameters

Each output parameter that is to be logged should be part of the Script.txt file. However,
the Script.txt file should contain only the details of one output parameter during the call to

MetricsReader.exe.

To log multiple parameters, multiple script files can be used. If n output parameters are to be
logged, then there can be scriptl.txt, script2.txt, script.txt in the sweeper folder. For
example, there can be two Script files as shown below:

E New -~ &6

« v oa

> % Home

> @ OneDrive - Personal
> [ ThisPC

> '8l Network

> ) Linux

Multi-Parameter-Sweeper-Example-2

0 B B W

Tl sort -

View ~

<« Multi-Parameter_Sweeper v13.2 5 Examples 5 Multi-Parameter-Sweeper-Example-2

~
MName

Data
10Path
[2] configwriter.dil
ConfigWriter.exe
o ConfigWriter.runtimeconfig.json
e inputxml
MetricsCsv.exe
[%] metricsreader.dil
MetricsReader.exe
LT MetricsReader.runtimeconfig json
"j' MultiParameterSweeper.m
D MultiParameterSweeper.py
m NetSimMetricsReader.dll
[%] NetSimXmIReader.dIl
B result.csv
5] Seriptl bt

D Script2.txt

17items 2 items selected 222 bytes

Date medified

Type
File folder

File folder

Application exten...

Application

JSOM File

Microsoft Edge H...

Application

Application exten...

Application
JSOM File
M File

Python source file

Application exten...
Application exten...

Microsoft Excel C...

Text Document

Text Document

v

171KB

KB

171KB

1KB

TKB

8KB

KB

1KB

1KB

Q. Search Multi-Para...

= O x

% Eror -
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Figure 5-1: Multiple output parameter script files
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5 Example 2: Multiple Input Parameters

Example 2 modifies multiple input parameters and logs multiple output parameter.

Consider the following Internetwork scenario in NetSim, comprising of a Wired Node, Router,
Access Point and a Wireless Node.

e l f 3
.-f*g ;\-.I .I_ i
> *{_‘}; 3 |x:mm‘.
Server_1 Router_2 -ﬁccess_'r:':-intj

|
|
|
:
11
|
|
|
|
|

.E“’CE‘E“

Figure 5-2: Network topology for the multiple-parameter sweep

Configure the scenario as follows:

e Set grid length to 60 m x 60 m grid setting property panel on the right. This needs to be
done before the any device is placed on the grid.

¢ Distance between Access Point and the Wireless Node is set to 10 m.

e Set DCF as the medium access layer protocol under datalink layer properties of access
point and wireless node. To configure any properties in the nodes, click on the node,
expand the property panel on the right side, and change the properties as mentioned in
the below steps.

e WLAN Standard is set to 802.11ac and No. of Tx and Rx Antenna is set to 1 in access
point and No. of Tx is 1 and Rx Antenna is set to 1 in wireless node (Right-Click Access
Point or Wireless Node > Properties > Interface Wireless > Transmitting Antennas and
Receiving Antennas) and Bandwidth is set to 20 MHz in both Access-point and wireless-
node Transmitter Power set to 100 mW in both Access-point and wireless-node.

e Wired Link speed is set to 1 Gbps and propagation delay to 10 us in wired links.

e Channel Characteristics: Path Loss Only, Path Loss Model: Log Distance, Path Loss
Exponent: 3.5.

e Configure an application between any two nodes by selecting a CBR application from the
Set Traffic tab in the ribbon on the top. Click on created application and expand the
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application property panel on the right and set transport protocol to UDP, packet size to
1460 B and Inter arrival time to 116.8 us.

o Application Generation Rate: 100 Mbps (Packet Size: 1460, Inter Arrival Time: 116.8

us).

¢ Run the simulation for 10 s.

The network scenario is saved and the content of the Configuration.netsim file is copied to
the Multi-Parameter-Sweeper directory and renamed as input.xml. Refer to the Example 2
directory which is part of the project folder:

Examples\Multi-Parameter-

Sweeper-Example-2

| Iﬂ = | Multi-Parameter-Sweeper-Example-2

Home Share View

5 Ao B x iIl 7 New item = \ﬂ_ ) open ~ [ selectan
w-| Copy path « £ Easy access = t Edit Select none
Pinto Quick Copy Paste Move Copy  Delete Remame — New u Properties = _
access E Paste shaortcut to~ ta~ - folder - 47 History DDInvertselectmn
Clipboard Organize New Open Select
<« v <« Multi-Parameter_Sweeper_v14.0-main » Examples » Multi-Parameter-Sweeper-Example-2 v O
P P P P
~
MName Date modified Type Size
7 Quick access
ConfigSuppert 07-12-2023 16:39 File folder
@ OneDrive - Personal %] configwriter.dil 14-03-2023 18:19 Application exten... 5KB
[ This PC [#5] ConfigWiriter.exe 14-03-2023 1819 Application 171 KB
o ConfigWriter.runtimecenfig.json 14-03-2023 18:19 JSOM File 1KB
o Metwork [ Inputaxml 07-12-2023 16:36 XML Document 38 KB
[#E] MetricsCsv.exe 14-03-2023 1819 Application 58 KB
|_'| metricsreader.dll 14-03-2023 1819 Application exten... 5KB
[#=] MetricsReader.exe 14-03-2023 12:19 Application 171 KB
o MetricsReader.runtimeconfig.json 14-03-2023 18:19 JSOM File 1KB
E MultiParameterSweeper.m 14-03-2023 1819 M File TKB
E MultiParameterSweeper.py 14-03-2023 18:19 Python File 3 KB
|_'| MetSimMetricsReader.dll 14-03-2023 18:19 Application exten... 10KB
|_'| MetSimXmlReader.dll 14-03-2023 1319 Application exten... 5KB
|j Script.bet 14-03-2023 1819 Text Docurment TKB
|j Scriptd bt 14-03-2023 18:19 Text Document 1KB

Figure 5-3: Renamed Configuration.netsim to input.xml and pasted in Multi- Parameter-Sweeper direc-

tory

In the Input.xml file the value of the input variables are modified as shown in the table below:

Copyright TETCOS LLP

Table 5-1: Variables modified in Input.xml

Input variable

Placeholder

Bandwidth (MHz)
Tx antenna count

Rx antenna count

{03
{1}
{2}

Inter-arrival time (us) {3}
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O e Bt Ve Gt Pject Dby ML Tt Ambee Tooh  Eemions Window Hep | B Smrche | Sohbon fspim - @ x
in-ol@-dsBE[9-C- - | poamach. - BB B B GaHub Copilot (&2
Inputent

<7xml version="1

encoding="UTF-8" standalones"no

a01/x8 5 g . emal ocation="Config xsa"s

DEVICE_I0-"1" TYPE-"NODE" WIRESHARK OPTION-*Dizable® INTERFACE COUNT-*1" DEVICE T

WiredHade . pn EVICES

</INTERFACE=

“Disable" INTER nternalfio

[ COUNT="2" DEVIC
WIRESRARK_OPTION="Disable" TNTERFACE_COUI
. 1>

3

/DEVICES]
* DEVICE_TCON-"AccessPoint . png">

<PROTOCOL_PROPERTY CONNECTION_MEDIUM="WIRELESS® STANDARD="IEEE892.11
<ANTEHNA SUBLAYER WAME="Antenna® ANTEWNA_HELGHT="1" ANTENNA_T
</PROTOCOL_PROPERTY>
</PROTOCOL>
</LAYVER>

* NUW_OF _AGGREGATED_PACKETS_AC="1" TX_T
mnidirectional Antenna® ANTENNA_GAIN=

UENCL!-ﬂNB:"S"I BANDWIOTH=" {8} "

FINTERFACE 10-"3" INTERFACE_NAWE-"Interface 3 (Et" INTERFACE TVPE-"ETHERNET">. ../ INTERFACES
</BEVICES

<)

>

[<DEVICE KEY-="

</DEVICE_CONFIGURATION>
> FCOWMECTTON>. </cONNECTION]
L SEPPLICATION_CONFTGURATT

<APPLICATION KEY="Unica:

</APPLICATION_CONFIGURATIONS
</NETWORK_CONFTGURATION>
[<STAULAT B

—"WirelessNode" DEVICE WAWE="STA " DEVICE ID-"4" TYPE-"NODE" WIRESHARK_OPTION="Disable" INTERFACE_ COUNT="1" DEVICE_ ICON-"Wirelesshode .pn">.. </DEVICEY

oW cou

INICAST* APPLICATION_TYPE=*CBR* TD="1" NAME="Appl_CBR" SOURCE_COUNT="1% SOURCE_TD=*1* DESTINATION_COUNT="1" DESTINATION_ID=*4* START_TIHE="0* END_TTHE="1|

Qo
TIoNs

R_SIHULATION E: * STNULATION TIME="10">...</SIMULATION PARAMETERS

3 [eeme
SSTATISTICS COLLECTION>...=/STATISTICS COLl
</TETCOS_NETSIN>
0% O ma e taum < b imas ons coies st cmr

Figure 5-4: The above table Variables are modified in input.zml file

The python script MultiParameterSweeper.py is modified to run simulation for all possible
combinations of Bandwidth and Tx Antenna Count and Rx Antenna Count with the respective
values of IAT that is calculated.

] File Edit Selection View Go Run - « £ search DEmm® - 2 x
@ % MultiParameterSweeperpy X @ Workspace Trust B~ M -
C: > Users > mihit > Desktop > Multi-Parameter_Sweeper v14.2 » Bxamples > Multi-Farameter-Sweeper-Example-2 > @ MultiParameterSweeperpy >
33
34 | bandwidth = [28, 48]
35 | Tx_Antenna_count = [2, 4, &, 8]
3—9 36 | Rx_Antenna_count = [2, 4, 6, 8]
37 | ref_iat = leeee
> 38 |
o 39 # Delete result.csv file if it already exists
48 if os.path.isfile("result.csv"):
g =« as. removel("result. csv)
a2 .
é 43 # create a csv file to log the output metrics for analysis —
44 csvfile = open("result.csv", "w")
45
46 # Add headings to the CSV file
47 csufile.write(
48 "CHANNELBANDWIDTH_MHZ, TX_ANTENNA_COUNT , RX_ANTENNA_COUNT, INTER_ARRIVAL_TIME(micro sec),Data Packets transmitted, THROUGHPUT(Mbps),”
49 )
58 csvfile.close()
51
52 # create a folder with name as year-month-day-hour.minute.seconds inside the data folder
53 today = time.strftime("%Y-%m-%d-%H.%M.%S")
54 foldername = str(today)
55
56  # Iterate based on the number of time simulation needs to be run and the input parameter range
57 k=@
58 for i in bandwidth:
59 for j in Tx_Antenna_count:
@ 60 for z in Rx_Antenna_count:
3 iat = ref_iat / ((i / 1@} * (j / 2))

if os.path.isfile("Configuration.netsim"):
os.remove("Configuration.netsim”)
o @ Ln41,Col28 Spaces:4 UTF-8 LF {} Python 3.12764-bit Q

Figure 5-5: Modified MultiParameterSweeper.py based on input parameter

Multiple parameters are read from the Metrics.xml file and logged in the results. csv file along
with the input parameters such as BANDWIDTH_MHz, TX_ANTENNA_COUNT, RX_ANTENNA_COUNT,
INTER_ARRIVAL_TIME (micro sec).
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Table 5-2: Output parameters configured in script files

Output parameter Script file

Throughput (Mbps) Scriptl.txt
Data packets transmitted Script2.txt

Two script text files namely Scriptl.txt and Script2.txt are created with information to
read each of the parameters from the Metrics.xml file. The variable OUTPUT_PARAM_COUNT is
set to 2 as per the number of Script files.

Scriptl.txt

| ] Script1.txt - Notepad — O >

| File Edit Format View Help

{MENU NAME="Application_Metrics”

TABLE NAME="Application Metrics™

|SET A="Throughput (Mbps)"™ WHERE "Application Id"="1"

Ln 3, Col 53 100%  Unix (LF) UTF-8

Figure 5-6: The application throughput is to be logged for each simulation modified in Scriptl.txt

Script2.txt

| Script2.xt - Notepad — O X

File Edit Format View Help

MENU MAME="Link_ Metrics"

TABLE NAME="Link_ Metrics”

SET A="Packets tr*ansmitted\bata" WHERE "Link_id"="Al1l1"

Figure 5-7: The Data Packets transmitted is to be logged for each simulation modified in Script2.txt

In the python script MultiParameterSweeper.py, MetricsReader.exe is called to log each pa-
rameter specified in the script text files separating the entries with a comma (”,”). If simulation
crashes, without generating the output Metrics.xml, then ”crash” message is written to the
log for each output parameter. The input parameters that were varied during each simulation

run are also logged in the results.csv file.
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148
149
156
151
152
153
154
155
156
157
158
159
160
161
162
163
164
165
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if os.path.isfile("Metrics.xml"):
# Write the value of the variable parameters in the current iteration to the result log

csvfile = open("result.csv", "a")
csvfile.write(
"\n" + str(i) + "," + str(j) + "," + str(z) + *,* + str(iat) + ","

csvfile.close()

if OUTPUT_PARAM_COUNT == 1:
# Call the MetricsReader.exe passing the name of the output log file for updating the log based on script.txt
os.system("MetricsReader.exe result.csv")
else:
for n in range(l, OUTPUT_PARAM_COUNT + 1, 1):
os.rename("Script” + str(n) + ".txt", "Script.txt")
os.system("MetricsReader.exe result.csv")
csvfile = open("result.csv", "a")
csvfile.write(”,")
csvfile.close()
os.rename("Script.txt", "Script" + str(n) + ".txt")

else:
# Update the output Metric as crash if Metrics.xml file is missing
csvfile = open("result.csv", "a")
csvfile.write(
e
str(i)
"
str(j)

+ o+

sér[z)

str(iat)

"crash"

L

csvfile.close()

Figure 5-8: Modify python script MultiParameterSweeper.py file

The simulation Configuration file and all the output files associated with each simulation run
is saved to folders with name including the bandwidth and DL MIMO count values that were
used during each simulation run.

MultiParameterSweeperpy & X

166
167
168
169
170
171
172
173
174
175
176
177
178
179
180
181
182
183
184
185
186
187
188
189
190
191
192
193
194
195
196
197

# Name of the Output folder to which the results will be saved

OUTPUT_PATH = (
"Data\\"

str(foldername)

"\\Output_"

str(i)

str(j)

str(z)

+ o+ o+ o+ o+

)

if not os.path.exists(OUTPUT_PATH):
o0s.makedirs(OUTPUT_PATH)

# create a copy of result.csv file present in sweep folder to date-time folder
if os.path.isfile("result.csv"):
shutil.copy(os.path.join("result.csv"), "Data\\" + str(foldername))

# Create a copy of all files that is present in IOPATH to the desired output location

files_names = os.listdir("IOPATH")
for file_name in files_names:
shutil.move(os.path.join("IOPATH", file_name), OUTPUT_PATH)

# Delete Configuration.netsim file created during the last iteration
if os.path.isfile("Configuration.netsim"):
os.remove("Configuration.netsim")

# Delete Metrics.xml file created during the last iteration

if os.path.isfile("Metrics.xml"):
os.remove("Metrics.xml")

Figure 5-9: Modify python script MultiParameterSweeper.py file

o Multi-Parameter Sweeping process is started by opening command prompt in the directory
of the Multi-Parameter-Sweeping project and starting the python script as shown below:
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| B CAWindows\System32\cmd.exe — O X

Figure 5-10: Running Fxample 2 from Command Prompt

This starts the Multi-Parameter-Sweeping process which runs NetSim simulations iteratively
for different combinations of input parameters. At the end of the process the Multi-Parameter-
Sweeping folder will have the following file and folders created:

v] = | Multi-Parameter-Sweeper-Exarmple-2
“ Home Share View
. o Cut = x _Il | mopen- FH select all
= — @ Copy path « J Edit Select none
Pinto Quick Copy Paste R, MD\:E Copvy Delvete Rename Propfrties - 9 | et selection
access to to v =
Clipboard Organize Open Select
< A <« Multi-Parameter_Sweeper_v14.0-main > Examples » Multi-Parameter-Sweeper-Example-2 v D
Mame : Type Size
#F Quick access
ConfigSupport File folder
@ OneDrive - Personal Data File folder
1 Thic PC I0Path File folder
4| configwriter.dll Application exten... 5 KB
¥ Network [ ConfigWriter.exe Application 171 KB
IT ConfigWriter.runtimeconfig.json JSON File 1 KB
| Inputxml AML Document B KB
[ MetricsCsv.exe Application 58 KB
| metricsreader.dll Application exten... 5KB
[ MetricsReader.exe Application 171 KB
LT MetricsReader.runtimeconfigjson JSOM File 1 KB
E MultiParameterSweeper.m M File TKB
[# MultiParameterSweeper.py Python File 3 KB
| MetSimMetricsReader.dll Application exten... 10 KB
4| NetSimXmlReader.dll Application exten... 5 KB
@ result.csv Microsoft Excel C... 6 KB
=| Scriptl.txt Text Document 1 KB
=| Script2.txt Text Document 1 KB

Figure 5-11: After Simulation Multi-Parameter-Sweeping folder contains output files like result.csv,

Data etc

e Data: The Data directory contains multiple output folders with the output files associated
with each simulation run.
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@ Mew

3 [ Desitop

Figure 5-12:

x |+
Q » Examples >  Multi-Parameter-Sweeper.
Tl Sort = view
N 26249 20115853
dame
2004-10-28-11.58.55 & voE
@ hew
> Dabaep

Cutput 92.2.4
Output 9226
Outpu 4028
Oupur 404 2
Output 304 4

A 4

Output 4.4 6

Output 4264

Output 4266
Output 068
Dutput %052
Output %88
Output #.66
Output 92,50

-Example-2 > Data » Search Data
x [
[ L » o Data »
Sert - = View
P G
Dutput 2 6.6
OQutput 0 62

& et o

25115652 »

Ver 15.0

El=

Based on input parameter Configuration.netsim and other files created in output folder

o IOPath: Used for storing the Configuration.netsim file and the simulation files gener-
ated during each simulation run.

e Result.csv: This is the output log which contains the parameter varied during each
simulation run and the output parameter associated with each run.

B 9~ i result.csv - Excel Nitin Yerra =
Home  Inset  Pagelayout  Formulas  Data  Review  View  Help @ Tellmewhat you wantto do
Al - I CHANNELBANDWIDTH_MHz
A B C D E F
1 |CHANNELBANDWIDTH_MHz .TX_ANTENNA_CDUNT RX_ANTENNA_COUNT INTER_ARRIVAL_TIME(micro sec) Data Packets transmitted THROUGHPUT(Mbps)
2 20 2 2 5000 5990 2.327824
3 20 2 4 5000 5990 2.327824
4 20 2 [ 5000 5990 2.327824
5 20 2 8 5000 5990 2.327824
6 20 4 2 2500 11982 4.659152
7 20 4 4 2500 11982 4.659152
8 20 a4 6 2500 11982 4.659152
9 20 4 2 2500 11982 4.659152
10 20 6 2 1666.666667 17973 6.988144
1 20 6 4 1666.666667 17973 6.983144
12 20 6 6 1666.666667 17973 6.988144
13 20 6 8 1666.666667 17973 6.988144
14 20 2 2 1250 23959 9.3148
15 20 8 a4 1250 23959 9.3148
16 20 38 6 1250 23959 9.3148
17 20 8 8 1250 23959 9.3148
18 40 2 2 2500 11982 4.659152
19 40 2 4 2500 11982 4.659152
20 40 2 6 2500 11982 4.659152
21 40 2 8 2500 11582 4.659152
22 40 4 2 1250 23959 9.3148
23 40 a4 a4 1250 23959 9.3148
24 40 4 [ 1250 23959 9.3148
25 40 a4 8 1250 23959 9.3148
26 40 6 2 833.3333333 35943 13.973952
27 40 6 4 833.3333333 35943 13.973952
28 40 6 6 833.3333333 35943 13.973952
29 40 [ 2 833.3333333 35943 13.973952
30 40 8 2 625 47345 17.950992
3 40 8 4 625 47929 18.63544
32 40 2 [ 625 47329 18.63544
33 40 8 8 625 47929 18.63544
34
result ® []

o Accessibility: Unavailable

H M -——+ 10m

Ready

Figure 5-13: Based on script result stored in result.csv file
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6 Advanced Use Cases

6.1 Running the Sweeper with Modified Workspace Binaries

When source code in a workspace is modified, NetSim may print a checksum warning in the
simulation console and wait for user input.

| 7 C\Users\HP\OneDrive\Documents\NetSim\Workspaces\Default Workspace v13_2 34\bin_x64\NetSimCore.exe = m] x

date is
build date

sers link their own code to NetSim.

Figure 6-1: Checksum warning shown while running with modified workspace binaries

To suppress the prompt, open the current workspace location from Your Work > Workspaces
> Open Workspace Location. Go to bin_x64 and rename the checksum file.
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| 9 = | bin_x64 — O e
Home Share View o
m"; Cut = x @ %New item - W ijpen @ HaSeIect all
w., Copy path « ﬁ Easy access = L__TEdit Select none
Pin to Quick Copy Paste Move Copy Delete Rename Mew Properties
access E] Paste shortcut to- to~ - folder - £ History DDIn\rert selection
Clipboard Organize Mew Open Select
<« v 4 <« Workspaces » 140VER » bin_x64 v L2 Search bin_x64
MName - Date modified Type Size ~
7 Quick access
5G_BLER File folder
@ OneDrive - Personal 5GBeamforming File folder
s [ This PC D AESEncryption.dll Application exten... 18 KB
T & AESEncryption.pdb Program Debug D... 1,156 KB
¥ Network D Animation.dll Application exten... 20 KB
& Animation.pdb Program Debug D... 596 KB
& AODVDILpdb Program Debug D... T16 KB
& ApplicationDll.pdb Program Debug D... T16 KB
& ARPDIlLpdb Program Debug D.. 332KB
D BatteryMaodel.dll Application exten... 15KB
& BatteryModel.pdb Program Debug D... 580 KB
& CellularDIlpdb Program Debug D.. 348 KB
D Checksum_backup.bet txt Text Document 3 KB
& ChecksumCalculator.pdb Program Debug D... 412 KB
D ChildProcess.dll Application exten... 13 KB
D ClLiinterpretor.dll Application exten... 29 KB
& Cllinterpretor.pdb Program Debug D... 812 KB
& CognitiveRadioDll.pdb : Program Debug D... 652 KB v
148items  1item selected 2.32KB  State: @R Shared =

Figure 6-2: Checksum.txt renamed in the workspace bin_x64 folder

6.2 Configurations with Supporting Files

Some NetSim configurations use additional files such as mobility files, static route files, ACL
input files, or SUMO configuration files for VANET studies. Place these files in the sweeper
folder and copy them into I0Path with Configuration.netsim before each run.

if os.path.exists("ConfigSupport"):
if os.path.exists("I0Path\\ConfigSupport"):
shutil.rmtree("I0Path\\ConfigSupport")
shutil.copytree("ConfigSupport", "IOPath\\ConfigSupport")

Figure 1: Copying supporting configuration files into IOPath
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